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Chapter 24

Imaging Presynaptic Exocytosis in Corticostriatal Slices

Minerva Y. Wong, David Sulzer, and Nigel S. Bamford 

Abstract

Optical imaging is a valuable tool for investigating alterations in membrane turnover and vesicle trafficking. 
Established techniques can easily be adapted to study the mechanisms of synaptic dysfunction in models of 
neuropsychiatric disorders and neurodegenerative diseases, such as drug addiction, Parkinsonism, and 
Huntington’s disease. Fluorescent endocytic tracers, including FM1-43, have been used to optically moni-
tor synaptic vesicle fusion and measure synaptic function in various preparations, including chromaffin 
cells, dissociated cell cultures, and brain slices. In this chapter, we describe a technique that provides a 
direct measure of pathway-specific exocytosis from glutamatergic corticostriatal terminals.
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Neurotransmitter release and reuptake from recycling synaptic ter-
minals is tightly regulated and alterations in vesicular turnover or 
in the availability of neuromodulators that act presynaptically can 
be features of neurodegenerative conditions (1). Optical tracers 
that label individual axon terminals in an activity-dependent man-
ner have become useful tools in neurobiology and are responsible 
for improving our understanding about membrane trafficking and 
synaptic activity. When combined with standard electrophysiologi-
cal techniques, optical recordings enable synapse modeling by 
showing how neuromodulators select subsets of presynaptic termi-
nals, leading to changes in postsynaptic activation.

Perhaps the first optical tracer to monitor neurotransmitter 
release used horseradish peroxidase, which in the presence of 
appropriate substrates can produce a colored or electron-dense 

1. Introduction
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reaction product (2). Eric Holtzman showed that synaptic vesicles 
in lobster muscle accumulate and then release horseradish peroxi-
dase upon stimulation (3), providing initial evidence that these 
organelles recycle and undergo multiple rounds of fusion with the 
plasma membrane.

Fluorophores were then adapted for endocytic labeling of syn-
aptic vesicles, initially using Lucifer yellow in photoreceptors (4). 
Shortly after Jeff Lichtman and colleagues (5) used rhodamine, 
fluorescein, and 8-hydroxypyrene (which emit in red, green, and 
blue wavelengths, respectively) and stimulated multiple nerves 
innervating a neuromuscular junction to identify which axon termi-
nals were associated with a particular nerve. Quantum dots have 
also been adapted for similar purpose (6). Additional classes of opti-
cal probes that have been used to study synaptic vesicle fusion are 
mutants of vesicle lumen proteins that possess pH sensitive mutant 
forms of green fluorescent protein (7). These “pHluorin” proteins 
have relatively low levels of emission in the typically acidic environ-
ment of synaptic vesicles, and become far brighter when exposed to 
the neutral extracellular milieu following fusion. Mutations of syn-
aptic vesicle transporters are sometimes used as such tracers (8). 
Finally, fluorescent false neurotransmitters are accumulated by 
synaptic vesicle transporters, providing both a means by which 
destaining can be measured during exocytosis and a means to estimate 
vesicle accumulation under a range of circumstances (9).

To date, the most successful approach for studying the activity 
of corticostriatal terminals has been to use fluorescent styryl dyes, 
particularly FM1-43. This class of probes offers distinct advan-
tages, including reversible staining, tissue impermeability and acti-
vated fluorescence when dissolved into the lipid bilayer membrane 
(10). These specialized qualities are bestowed by a positively 
charged head, which prevents membrane permeability, and a lipo-
philic tail of varying length that defines the dye’s spectral proper-
ties and washout kinetics (11). The compounds can also, like 
horseradish peroxidase, be used to form an electron dense reaction 
product (12) and a fixable derivative is available (13).

The FM dyes differ from other fluorescent tracers in that they 
are “amphiphilic” and can partition into membrane or aqueous 
media, but are most fluorescent when associated with lipid. Thus, 
the probe initially brightly labels the extracellular membrane. When 
neuronal stimulation induces endocytosis, the vesicle membrane 
becomes exposed to the synaptic cleft and FM1-43 is internalized 
within the recycling synaptic vesicle. When the synaptic vesicle 
membrane is endocytosed, FM1-43 fluorescence is visualized as 
bright fluorescent puncta. Restimulation produces exocytosis of 
recycling dye-loaded vesicles, FM1-43 is released into the extracel-
lular medium or is dispersed in the surrounding membrane (14) 
and the fluorescence intensity of the terminal declines as it is des-
orbed from the membrane.
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Preliminary evidence for the success of FM1-43 was demonstrated 
by William Betz and colleagues in frog, rat, and mouse motor 
nerve terminals (10). More recently, FM1-43 has been used to 
study secretory activity in chromaffin cells (11), cultured neurons 
(15, 16), as well as in hippocampal (17) and corticostriatal brain 
slices (18–21). Destaining of FM1-43 typically follows first to second 
order kinetics (15, 21) and is calcium dependent (18, 21), consis-
tent with regulated neurotransmitter release.

An early identified impediment to using FM1-43 in brain slices 
was nonspecific “adventitious” binding of the dye that resisted 
washing and obscured the clear visualization of synaptic terminals. 
This problem was minimized following the introduction by Alan 
Kay of a carrier molecule, a sulfobutylated derivative of b-cyclodextrin, 
named ADVASEP-7 (22). This carrier was found to have a higher 
affinity for FM1-43 than plasma membranes and extracellular mol-
ecules, allowing for an efficient removal of FM1-43 from the extra-
cellular space, and thus significantly reduced background staining. 
Additionally, two-photon laser-scanning microscopy (TPLSM) of 
FM1-43-labeled presynaptic terminals was found to be a superior 
method for visualizing dynamics of vesicle release and uptake (17, 
23). Compared to confocal laser microscopy, TPLSM preserves 
tissue health by requiring less energy (at twice the wavelength), 
suppresses background fluorescence by membrane-bound FM1-43, 
increases the depth of excitation and leads to better imaging reso-
lution of individual presynaptic boutons deep within a slice (24). 
Thus, we have found that optical imaging of presynaptic release in 
brain slices with FM1-43 is optimized by using TPLSM along with 
the external application of ADVASEP-7.

Here, we describe a technique that provides a direct measure 
of pathway-specific exocytosis from glutamatergic corticostriatal 
terminals. We provide instructions for loading FM1-43 into striatal 
terminals via nonspecific potassium-driven endocytosis and by 
pathway specific cortical stimulation. The instructions are tailored 
toward investigators with some experience in electrophysiology 
and knowledge of TPLSM function and tuning.

	 1.	Artificial cerebrospinal fluid solution (ACSF): 109 mM NaCl, 
5 mM KCl, 35 mM NaHCO3, 1.25 mM NaH2PO4, 20 mM 
HEPES, 1 mM MgCl2, 2 mM CaCl2, and 10 mM glucose (pH 
7.3–7.4, 295–305 mOsm; see Note 1).

	 2.	High potassium (K+) ACSF: 74  mM NaCl, 40  mM KCl, 
35  mM NaHCO3, 1.25  mM NaH2PO4, 20  mM HEPES, 
1 mM MgCl2, 2 mM CaCl2, and 10 mM glucose (pH 7.3–7.4, 
295–305 mOsm; see Note 1).

2. Materials

2.1. Media
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	 1.	Zeiss LSM 510 NLO TPLSM equipped with a titanium-
sapphire laser (excitation 810  nm/emission 650  nm; Carl 
Zeiss, Germany; see Notes 2 and 3).

	 2.	Plan Fluor ×40 oil-immersion objective (NA 1.3; Zeiss).
	 3.	IBM computer.
	 4.	Software.

(a)	 LSM 510 Browser software (Zeiss).
(b)	 Image J (Wayne Rosband, National Institutes of Health, 

Rockville, MD).
(c)	 SigmaPlot (SPSS, Chicago, IL), Excel (Microsoft, WA) or 

another graphics software package.

	 1.	FM1-43 (8 mM; N-[3-(triethylammonio)propyl]-4-(4-dibutyl-
aminostyryl) pyridinium dibromide; Invitrogen, Carlsbad, 
CA). Protect from light (see Note 3).

	 2.	ADVASEP-7 (CyDex, Overland Park, KS).
	 3.	NBQX (10 mM; 2,3-dihydroxy-6-nitro-7-sulphamoylbenzo(f)-

quinoxaline-2,3-dione; A.G. Scientific, San Diego, CA).
	 4.	APV (50  mM; D-2-amino-5-phosphonovaleric acid; Sigma,  

St. Louis, MO).
	 5.	CPCCOEt (40 mM; 7-(hydroxyimino) cyclopropa(b)chromen-

1a-carboxylate ethyl ester; Tocris Bioscience, Ellisville, MO).
	 6.	RC-27  L slice incubation chamber (56  mL/mm; Warner 

Instruments, Hamden, CT).
	 7.	Custom slice anchor (see Note 4).
	 8.	Twisted tungsten bipolar electrode (22  mm; Plastics One, 

Roanoke, VA).
	 9.	Tektronix R564B wave generator (Tektronics, Gaithersburg, 

MD).
	10.	Stimulation isolator (AMPI, Jerusalem, Israel).
	11.	S88 storage oscilloscope (Grass-Telefactor, West Warwick, 

RI).
	12.	Carbogen gas (95% O2, 5% CO2).

Optical imaging of release from corticostriatal terminals is mea-
sured using the endocytic tracer FM1-43, which reports synaptic 
vesicle fusion activity at individual terminals, using techniques 
introduced previously (18–21). In brain slice preparations, TPLSM, 

2.2. Equipment for 
Two-Photon Excitation 
Time-Lapse Imaging

2.3. Chemicals  
and Supplies

3. Methods
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combined with the judicious use of the adventitious quencher 
ADVASEP-7, provides a high signal to noise ratio and excellent 
three-dimensional spatial resolution with minimal photo bleaching 
and photo damage (24).

	 1.	Prepare 1 L of ACSF and perfuse with carbogen gas. Check 
pH and osmolarity.

	 2.	Isolate 50 cc of the ACSF, bubble in carbogen and cool in an 
ice bath.

	 3.	Anesthetize mice with nembutal 200 mg/kg i.p. or other agent 
prior to sacrifice.

	 4.	Decapitate, rapidly remove the brain and sever the cerebellum.
	 5.	Affix the caudal portion of the forebrain to a vibratome tissue 

holder using a few drops of cyanoacrylate glue and fill the 
holder with the prepared ice-cold ACSF.

	 6.	Cut tissue using a vibratome into four to six 250 mm-thick 
coronal sections, containing the cortex and striatum between 
bregma +1.54 and +0.62 (25).

	 7.	Bisect each coronal section at the midline creating two half-
sections, each containing a hemisphere and striatum (see Fig. 1); 
remove to a slice holding chamber filled with carbogenated 
ACSF at room temperature.

	 8.	Allow slices to recover for at least 1 h prior to use.
	 9.	Prepare the following solutions, store in foil-lined plastic con-

tainers and bubble with carbogen for a few min just prior to 
using.
(a)	 8 mM FM1-43, 10 cc in High K+ ACSF.
(b)	 1 mM ADVASEP-7, 10 cc in ACSF.
(c)	 100 mM ADVASEP-7, 10 cc in High K+ ACSF.
(d)	 8 mM FM1-43, 10 cc in ACSF.
(e)	 100 mM ADVASEP-7, 500 cc in ACSF.

	 1.	Activate and tune the TPLSM (see Subheading 2.2).
	 2.	Place a single corticostriatal slice in the imaging chamber with 

the cortex facing the electrodes (see Fig. 1a). Place the slice 
anchor over the slice so that harp strings run parallel with the 
corticostriatal fibers. Perfuse with warmed (35°C) carboge-
nated ACSF at 2–3 mL/min.

	 1.	Load FM1-43 nonspecifically into striatal terminals with high K+.
	 2.	Stop ACSF perfusion, close the suction, and remove most of 

the ACSF from the imaging chamber. Slowly add 2 ml of FM1-
43 in high K+ ACSF (see Step 9a in Subheading 3.1) to the 

3.1. Preparation  
of the Corticostriatal 
Slice

3.2. Preparation  
for Optical Imaging 
with FM1-43

3.3. Loading  
and Unloading FM1-43 
Using High K+



Fig. 1. (a) A corticostriatal slice stained with 3,3¢-diaminobenzidine shows the areas of stimulation and recording. Corticostriatal 
terminals are loaded with FM1-43 by electrical stimulation with bipolar electrodes placed over cortical layers V–VI (Cortical 
Electrodes), located 1.5–2.0 mm from the imaging site. Multiphoton images of corticostriatal terminals are obtained from the 
corresponding motor striatum. Dopamine can be released by amphetamine or by local striatal stimulation (Striatal Electrode). 
CC corpus callosum, AC anterior commissure. Bar, 1 mm. (b) Protocol for loading and destaining corticostriatal terminals with 
FM1-43. (c) Multiphoton images of corticostriatal terminals captured every 21.5 s from the dorsal striatum revealed an en 
passant array of corticostriatal terminals. Restimulation at t = 0 with 10 Hz pulses shows activity-dependent destaining of fluo-
rescent puncta. Bar, 2 mm. (d) Time-intensity analysis of FM1-43 release from individual puncta (n = 18), shown in panel C, 
demonstrate diverse terminal kinetics. Stimulation began at t = 0 s. (e) Mean fluorescence intensity of puncta over time shown 
in Panel c and d is compared to a first-order exponential curve. The plateau line represents fluorescence measurements from 
a nondestaining punctum (reproduced from see ref. 21 with permission from the Society of Neuroscience).
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imaging chamber with a pipette. Bubble FM1-43 gently with 
carbogen applied locally using a micropipette (see Note 5).

	 3.	Allow at least 2 min for the FM1-43 to load into synaptic ter-
minals. Remove FM1-43 in high K+ ACSF and add 2  cc of 
1 mM ADVASEP-7 (see Step 9b in Subheading 3.1) with a 
pipette. Bubble ADVASEP-7 gently with carbogen for 15 min. 
This will help to remove adventitious staining.

	 4.	Focus the TPLSM on the striatum and capture images of fluo-
rescent puncta (see Subheading 3.5 and Fig. 2).

	 5.	After 9 baseline frames, continue TPLSM scanning and unload 
FM1-43 by superfusion with high K+ ACSF with 100  mM 
ADVASEP-7 (see Step 9c in Subheading 3.1 and Note 6).

	 1.	Load FM1-43 specifically into corticostriatal terminals.
	 2.	Using a fresh brain slice, attach bipolar electrodes to a micro-

manipulator and gently place the electrodes over cortical layers 
V–VI (see Note 7 and Fig. 1).

	 3.	Stop ACSF perfusion, close the suction and carefully add 2 ml 
of FM1-43 (see Step 9d in Subheading 3.1) into the imaging 
chamber with a pipette. Bubble FM1-43 gently with carbogen 
(see Note 5).

	 4.	Allow 10 min for the FM1-43 to penetrate the slice.
	 5.	Load FM1-43 into corticostriatal presynaptic terminals using a 

10 min train of 200 ms, 400 mA pulses at 10 Hz (see Figs. 1 
and 2).

	 6.	Stop stimulation. Without bumping the electrodes, carefully 
remove FM1-43 and add 1 mM ADVASEP-7 (see Step 9b in 
Subheading 3.1) with a pipette. Bubble ADVASEP-7 gently 
with carbogen, applied locally using a micropipette, for 2 min 
to remove adventitious staining.

	 7.	Open suction drain and perfuse slices in ACSF containing 
100 mM ADVASEP-7 (see Step 9e in Subheading 3.1 and Note 6).

	 8.	To prevent feedback synaptic transmission, expose sections to 
the pharmacological agents NBQX (AMPA receptor blocker), 
APV (NMDA receptor blocker), and CPCCOEt (to block 
metabotropic glutamate receptors).

	 9.	Dopamine can be released by amphetamine or by local striatal 
stimulation. Likewise, receptor ligands can be bath-applied to 
detect alterations in FM1-43 destaining (see Fig. 1 and Note 8).

	10.	Focus the TPLSM on the striatum and capture images of fluo-
rescent puncta (see Subheading 3.5 and Figs. 1 and 2).

	11.	After 9 baseline frames, continue TPLSM scanning and deliver 
200  ms, 400  mA pulse trains to the cortex at 10  Hz for 
10 min.

3.4. Loading  
and Unloading FM1-43 
Using Cortical 
Stimulation
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Fig. 2. Labeling striatal synaptic terminals with FM1-43. (a) TPLSM image of the dorsal striatum 
shows dramatic adventitious staining following incubation of a striatal slice in FM1-43 (8 mM) 
for 10 min, followed by a 5 min wash in ACSF. The more darkly stained ovals are bundles of 
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	 1.	Fluorescent corticostriatal terminals are visualized using a Zeiss 
TPLSM system. Images captured in 8-bit, 123 × 123  mm 
regions of interest (ROI) at 512 × 512 pixel resolution and 
acquired at 21.5 second time intervals (see Notes 2 and 3).

	 2.	During each time interval, obtain a z-series of five images, sep-
arated by 1 mm in the z-plane. This will compensate for any 
minor z-axis shift.

	 3.	Collect image stacks for 40 time intervals (3,600 s; 200 images). 
Perfuse with high K+ ACSF (see Step 5 in Subheading 3.3) or 
begin cortical stimulation at the start of the tenth time interval 
(see Step 11 in Subheading 3.4).

	 1.	Condense the image stack. Using the LSM 510 Browser soft-
ware, align images in each z-series, condense the z-series stack 
with maximum transparency and export the 40 condensed 
images to a folder in tiff format (see Note 9).

	 2.	Prepare the image stack for analysis (see Note 10).
	 3.	Identify fluorescent puncta measuring 0.5–1.5 mm in diameter 

(see Note 11).
	 4.	Measure average FM1-43 fluorescence intensity of each punc-

tum over the course of the time series (see Note 12).
	 5.	Subtract the background fluorescence. Identify an area of tis-

sue with no fluorescent puncta. Measure a sample of the slice 
background fluorescence for each time interval and subtract 
from the fluorescence intensity of each individual punctum.

	 6.	Normalize the fluorescence intensity. For each punctum, nor-
malize the time-dependent fluorescence intensity by the maxi-
mal puncta fluorescence just prior to the application of 
destaining stimulation (time frame 9).

	 7.	Graph the normalized, background subtracted, intensity of 
each individual punctum using SigmaPlot software or another 
graphics software package. Active terminals are identified by 
the exponential decay of fluorescent intensity following stimu-
lation (see Fig. 1 and Note 13). Reject any punctum that does 

3.5. Two-Photon Image 
Acquisition

3.6. Data Analysis

Fig. 2 (continued) corticofugal axons that course through the striatum. (b) When ADVASEP-7 
(1 mM) was applied to the slice, most of the background staining was removed, leaving a few 
solitary puncta (Arrow head) and residual staining of larger diameter tube-like structures 
(Arrow), likely representing myelinated fibers or blood vessels. (c) FM1-43 in high K+ ACSF 
followed by ADVASEP-7 produced multiple fluorescent puncta. (d) Panel C was magnified 4×, 
revealing puncta with diameters of ~0.5–2 mm. (e) FM1-43 was loaded into synaptic termi-
nals using cortical bipolar stimulation at 10 Hz for 2 min. A progressively greater number of 
fluorescent puncta were seen after cortical stimulation for (f) 5 and (g) 10 min. (h) Magnifying 
panel G by 4×, revealed puncta with diameters of ~0.5–2 mm. Bar, 20 mM for panels a–c and 
e–g and 5 mM for panels d and h.
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not begin to destain following stimulation. Determine the 
halftime of fluorescence intensity decay during destaining 
(t1/2). Average the fluorescence intensity for all punctum 
across the time interval using Excel software or other software 
(see Fig. 1).

	 8.	The fractional release of dye for each stimulation pulse can be 
determined using SigmaPlot software (see Note 14).

	 1.	Mix solutions fresh each day. Alternatively, a 10× solution of 
salt (NaCl, KCl, NaHCO3, NaH2PO4, and HEPES) and a 10× 
solution of MgCl2 and CaCl2 can be prepared ahead of time 
and stored at 4°C for several weeks. The two 10× solutions are 
combined together with dH2O on the day of experiment and 
glucose is added. HEPES is used to help reduce slice edema 
and secondary movement artifact (26).

	 2.	Several alternative TPLSMs can be used. We also use a Prairie 
Ultima TPLSM equipped with a titanium-sapphire laser (exci-
tation 900 nm/emission 625 nm; Prairie, Middleton, WI), a 
Plan Fluor ×60 water-immersion objective (NA 1.2; Olympus) 
and an IBM computer with Prairie View software (Prairie). 
When using a Prairie TPLSM, images are captured in 16-bit, 
75.2 × 75.2 mm ROI at 512 × 512 pixel resolution and acquired 
at 35-second intervals. An upright or inverted TPLSM can be 
used. In our experience, an upright microscope provides the 
best resolution (as the beam does not travel through a cover 
slip) while an inverted microscope affords a reduction in move-
ment artifact. Whether inverted or upright, the TPLSM 
requires a stage platform and at least one electrode-holding 
micromanipulator.

	 3.	FM1-43 dye has a single photon excitation maximum at 
479  nm. The ideal laser excitation wavelength using two-
photon imaging in these experiments should be determined to 
achieve adequate fluorescence signal yet maintain minimal laser 
power usage to reduce photo-bleaching of FM1-43. Optimal 
laser excitation wavelength and power (generally around ~10%) 
may vary between different set-ups. The pixel size (typically 
0.22 mm) may vary, depending on chosen parameters. To fur-
ther prevent photo-bleaching of the dye, minimize the inten-
sity of mercury epifluorescence and bright field light and limit 
the duration of light source use in the presence of FM1-43.

	 4.	Slice anchors are constructed from platinum wire and lycra 
threads with 1 mm spacing. An appropriately designed anchor 
will hold the brain slice in place while in the chamber bath and will 

4. Notes
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reduce the amount of slice movement during imaging. Fabricated 
slice anchors are also available from Warner Instruments.

	 5.	Carbogen is applied locally using a small (1–10  mL) plastic 
micropipette. Attach a gas line to the micropipette. Place the 
tip of the pipette into the imaging bath, directing the flow of 
gas away from the brain slice. Minimize the gas flow so that the 
slice is not agitated.

	 6.	ADVASEP-7 will help prevent recurrent endocytosis of FM1-
43 dye into the recycling synaptic vesicles.

	 7.	Robust placement of the stimulating electrode and imaging 
region are critical. Follow the referenced figure closely.

	 8.	Amphetamine (10 mM) can be bath applied to release dop-
amine from nigrostriatal terminals (18). Dopamine (with 
other neurotransmitters) can also be released using a separate 
set of bipolar electrodes placed over the striatum, just adjacent 
to the imaging region. Striatal stimulation at 0.1 Hz produces 
little change in FM1-43 release while providing pulsatile 
dopamine efflux (18). To ensure equilibrium, the brain slice is 
generally exposed to pharmacological agents for 10 min before 
stimulation-mediated unloading (see Fig. 1).

	 9.	Start the Zeiss LSM Image Browser and import the imaging 
file: name.lsm. To condense the z-stack, create a projection 
image: Process<Projections. The Projection window will open. 
Set the following parameters: Transparency = Maximum, Turning 
Axis = X, First Angle = 0, Number of Projections = 1, Difference 
Angle = 0. Uncheck Single Time Index option. Choose 
“Apply”. The projection image with 40 slices will open in a 
new window. Export the condensed images to tiff files. 
File>Export>Set: Save as type “Tagged Image File 16-bit”. 
Label the files xxx-0.tif through xxx-39.tif.

	10.	Open the condensed image series in ImageJ software (v. 1.43u).
	(a)	 Start ImageJ and import the condensed image files. 

File>Import>Image Sequence. Choose the first image of 
the stack “xxx-0.tif”. The Sequence Options dialog box 
opens; leave at the default settings. Choose “OK”.

	(b)	 Set properties of the images acquired on the TPLSM. 
Image>Properties>Type “microns” as “Unit of Length” 
and assign the appropriate pixel width, height and depth 
(0.22 mm; see Note 3). Choose “OK”.

	(c)	 Identify puncta by setting the threshold range of fluores-
cence intensity. Image>Adjust>Threshold. The Threshold 
window will open. The “Auto” function generally gives a 
good result. Select “Default”, “B&W”, and “Dark 
Background”. Choose “Apply”. If the “Convert to Mask” 
window opens check “Black Background” and OK. Close 
the Threshold window.
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	11.	In ImageJ, select Analyze>Analyze Particles. Set size to 
0.25–2.25. As nerve terminals are generally 0.5–1.5 mm in 
diameter, the software requires the square of this range of 
values or 0.25–2.25. Adjust the circularity of desired objects 
to be identified, if desired. Select “Outlines” under the 
“Show” option. Check “Display Results”, “Clear Results”, 
“Add to Manager”, and “Exclude on Edges”. Choose 
“OK”. Choose “No” when asked to process all 40 images. 
A Drawing window opens. This shows the location of fluo-
rescent puncta on the first image of the sequence.

	12.	Identify puncta over the remaining time points of the image 
sequence.
	(a)	 In the “Results” window, Select Edit<Set Measurements. 

Select “Area”, “Mean Gray Value”, “Display Label”, and 
then “OK”.

	(b)	 To ensure analysis of the time series, reselect the original 
image stack.

	(c)	 Within the “ROI Manager” window, select all of the listed 
codes. Click the first code, shift bar then click on the last 
code. Select “More” and “Options”. Within the Options 
dialog box, select “Associate ‘show all’ ROIs with Slices” 
and then “OK”.

	(d)	 Within the “ROI Manager” window, select “More” and 
click “Multi-Measure”. Check the option to “Measure All 
Slices” only. Choose “OK”.

	(e)	 Save data as an excel spreadsheet. Results<File<Save As: 
name.xls and organize the data within Excel.

	13.	Nearness of fit to first-order kinetics is determined by compar-
ing FM1-43 destaining with A=100*EXP (ln(0.5)*t/t1/2) (an 
integrated form of the first-order kinetics equation, -d[A]/
dt=k[A]), using the square of the correlation coefficient  
(R2; see Fig. 1e).

	14.	Fractional release (f) provides a measure of the change in fluores-
cent intensity over time. Calculate f  for each punctum from ln 
(F1/F2)/DSTIM (21, 27), where ln is the natural logarithm,  
F1 and F2 are the fluorescent intensities at t1 and t2, respectively, and 
DSTIM is the number of stimuli delivered during that period.
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